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ABSTRAKT
V teoretické části se práce obecně zaměřuje na historii a vývoj knihovny workflow, stručně
popisuje její nejdůležitější vlastnosti a možnosti, čímž poskytuje čtenáři základy, potřebné
k porozumění a orientaci v dané tematice. V praktické části je pak podrobně rozebrán
jeden ukázkový příklad, ukazující možnosti, flexibilitu a výhody spojení knihoven WF
a WPF. Především práce v příkladě využívá nejrozšířenější model workflow a ukazuje
čtenářům jak předávat informace mezi workflow a WPF.
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ABSTRACT
The theoretical part of the thesis generally focuses on history and development of work-
flow library, briefly describing most important features and options, which gives the reader
basics needed to understand and orientation in the topic. In practical part of the thesis is
detailly analized prime example, which is showing options, flexibility and advantages of
connecting WF and WPF libraries. Primarily the thesis uses the most widely used model
and shows how to pass information between workflow and WPF.
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ÚVOD
V dnešní době se programovací jazyky snaží co nejvíce přizpůsobit problémům,
usnadnit práci programátorům a obsáhnout co největší množství příkazů a hlavně
rěšení různých problematik. Windows Workflow Foundation (WF) je programovací
model, sada nástrojů a runtime prostředí, které umožňuje psát deklarativní workflow
tvořící model průběhu vašich programů na platformě Windows. Verze WF o které
budu pojednávat v této práci byla vydána jako součást .NET Framework verze
4 a je označována jako WF4. Workflow Foundation je díky možnosti modelování
workflow pomocí visuálního designeru velmi přehledné a díky možnostem užití jak
předdefinovaných, tak uživatelem vytvořených aktivit velmi lehce implementovatelné
na jakýkoliv problém. Díky možnosti tvoření vlastních aktivit se nabízí uplatnění
workflow například ve velkých týmech, kde se programátoři zaměří na vytvoření
zmíněných aktivit, a manažeři z nich následně sestaví workflow dle jejich potřeb. V
této práci se na příkladu pokusím ukázat, jak v jedné aplikaci spojit výhody WF a
WPF.
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1 ŘEŠENÍ STUDENTSKÉ PRÁCE

1.1 Historie Workflow Foundation
• Workflow Foundation se poprvé objevilo jako část .NET Frameworku verze

3.0, a využívalo hlavně jmenné prostory: System.Workflow.Activities, System.-
Workflow.ComponentModel, a System.Workflow.Runtime. Ve verzi 3 byly Work-
flow tvořeny za použití Sekvenčního modelu (Sequential model), ve kterém
jsou aktivity vykonávány v pořadí, v jakém byly sestaveny, a to vždy tak, že
ukončení jedné aktivity vede ke spuštění aktivity následující, nebo Stavového
modelu (State machine model) ve kterém jsou aktivity spouštěny jako reakce
na vnější události.

• V .NET 3.5, byla představena nová aktivita s názvem ReceiveActivity, díky
které mohou Workflow reagovat na příchozí Windows Communication Foun-
dation zprávy. Nové funkce Workflow ve verzi 3.5 používají jmenný prostor
System.ServiceModel.

• V .NET 4.0,byla Windows Workflow Foundation široce modernizována o nové
funkce jako Data Contract Resolver, Flowchart, a ostatní flow control aktivity.
Workflow ve verzi .NET 4 používá jmenný prostor System.Activities. Nejvý-
znamější změnou je, že zde už není Workflow Runtime objekt jako v předcho-
zích verzích. Workflow se namísto něj spouštějí přímo za použití WorkflowAp-
plication nebo WorkflowInvoker. Aktivity vytvořené v přechozích verzích .NET
Frameworku se dají spouštěť v .NET 4 workflow za použití Interop aktivity.

• WF4 následovala aktualizace .NET 4.0 Platform Update1, která hlavně při-
nesla možnost využívat StateMachineWorkflow v designeru a nové třídy: Sta-
teMachine, State, FinalState, Transition, StateMachineQuery, StateMachine-
StateRecord.

• Poslední dosud vydanou verzí je WF4.5, která je součásti .NET Frameworku
4.5. Tato verze nově podporuje využívání jak C# tak VB výrazů. Dále přináší
Workflow Identity & Versioning, který pomáhá v kompatibilitě mezi jednotli-
vými verzemi.
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1.2 Workflow knihovna
Workflow knihovna umožňuje:

• Plánovat a spouštěť workflow a aktivity. Workflow může být spuštěno třemi
způsoby:

1. Pomocí WorkflowInvokeru, který spustí workflow na stejném vlákně, ze
kterého je volán(to znamená, že není vytvořeno nové vlákno pro work-
flow). V tomto případě proces, který workflow zavolal počká, dokud work-
flow neskončí, a náslědně pokračuje. Hodí se pro malé workflow, kde není
potřeba rozsáhlých možností WorkflowApplication.

2. Pomocí WorkflowApplication, která spustí workflow na novém vlákně
(aplikace tedy není pozastavena po dobu, kdy je je vykonáváno workflow).
Vhodné pro větší worfklow, kde může být potřeba například pozastavit
workflow pomocí bookmarků či jinak ovládat průběh.

3. Pomocí WorkflowServiceHost, který spustí workflow jako WCF Službu.
Vzniklá workflow služba náslědně typicky získává vstupní data ze sítě pro
aktivity, které obsahuje.

• Určovat v jakém pořadí se budou vykonávat jednotlivé aktivity. Model vykoná-
vání Workflow může být sestaven pomocí aktivit jako Flowchart, If, Sequence,
Pick a Parallel vizuálně přes designer. Ve verzi 4 a výše lze nově používat
StateMachine aktivity, přinášející nový způsob tvorby modelu.

• Uchovávání workflow. Při uchovávání workflow se data z workflow uloží na pře-
chodné medium (například SQL Server) a uvolní workflow z paměti. Workflow
může být znovunačteno po určité době nebo pokud obdrží zprávu. Odstra-
něním nečinných workflow z paměti můžeme velmi navýšit počet aktivních
workflow, které systém může ovládat, a tedy zvýšit škálovatelnost.

• Spravovat data pro probíhající aktivity. Data spotřebovávají aktivity používá-
ním argumentů a proměnných, které jsou potřebné pro běh aplikace. Používání
argumentů a proměnných k ukládání dat pro aktivity znamená, že má aplikace
kdykoliv ve svém průběhu přístup ke konečnému stavu aktivity pro případ, že
by jej bylo nutné zachovat. Aplikace může též v průběhu předávat příchozí
zprávy a data konkrétním workflow instancím v případě, že běží několik work-
flow současně.

• Využívat vestavěný „tracking provider“, který zaznamenává vestavěné Work-
flow události (jako začátek, dokončení či selhání aktivity), nebo vlastní aktivity
(sledování určitých dat vlastní aktivity). Základní „tracking provider“ v .NET
Frameworku verze 4 zaznamenává sledované události do originálního záznamo-
vého souboru Windows, ale uživatelem definovaný „tracking provider“ může
být naprogrmován k ukládání sledovaných událostí i do jiných uložišť.
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• Poskytuje budoucí rozšiřitelnost formou Workflow Extensions(=rozšíření). Roz-
šíření jsou uživatelem definované objekty, přidané do workflow prostředí, které
poskytují uživatelem definované funkce, jako rozšířené možnosti komunikace s
hlavním procesem nebo specifické funkce sledování procesů.

• Využívat visualní ladění projektu pomocí workflow designeru. Workflow mohou
být spouštěna a laděna ve vývojovém prostředí za použití stejné zarážky a
krokování jako v ladícím kódu.

1.3 Druhy Workflow modelů
Různé druhy aplikací potřebují různý přístup k jejich řešení, a tím pádem také
různé modely vykonávání. Některé programy potřebují být co nejrychleji vykonány,
zatímco ostatní mohou běžet týdny nebo měsíce. Jiné zas potřebují být vykonány
ve velmi přesných krocích s pokud možno žádnou odchylkou od naplánovaného prů-
běhu. Další potřebují být více flexibilní, aby mohli reagovat na akce uživatelů a
podle nich měnit svůj průběh. Díky Windows Workflow Foundation (WF) tohoto
můžeme dosáhnout pomocí vytvoření modelů, složených z aktivit, které jsou pou-
žitím Activity typu(přesněji System.Workflow.ComponentModel.Activity). Pro vy-
tvoření workflow použijeme jednu či více aktivit z WF knihovny, vetšinou ve spojení
s námi definovanými aktivitami, a spojíme je v určitém pořadí, aby výsledný model
vyhovoval našemu řešení. Aktivity můžeme rozdělit na dvě základní skupiny: První
jsou jednoduché aktivity(Simple activities, často označované jako též „leaf“ activi-
ties), které dokáží spouštět libovolný kód, zapisovat data do databází, posílat emaily
nebo spouštět sady pravidel. Druhým typem jsou složené aktivity(Composite acti-
vities), které nemají konkrétní funkci po spuštění, ale spíše spouštějí jejich potomky
v předem známém pořadí, čímž ovládají tok ve workflow. Jednoduchým příkladem
složené aktivity může být například aktivita, která spouští dva potomky: jeden po-
tomek pošle email a druhý zapíše do systému data o odeslaní. Ve většině případů
tedy používáme složené aktivity.

Samotné WF je vydáváno s velkým množstvím složených aktivit, které mohou
být spouštěny přímo pomocí WorkflowRuntime. Je také vydáváno se třemi spe-
ciálními aktivitami, které jsou často označovány jako „Kořenové“ modely. Jsou to
SequentialWorkflowActivity,FlowChartWorkflowActivity a StateMachineWorkflowActi-
vity. Důležité je ale vědět že i přes jejich časté označování jako „Kořenové“ modely
se k nim WorkflowRuntime chová naprosto stejně jako k ostatním aktivitám.
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1.4 Vzorový příklad
V této práci bych Vás rád seznámil s praktickým příkladem využití workflow verze
4.0. Bohužel se mi nepodařilo zprovoznit aplikaci piškvorek za pomocí workflo a
tak nám jako ukázkový model poslouží poměrně jednoduchá aplikace pro výpočet
kvadratických rovnic. Tato aplikace bude používat několik Windows Presentation
oken, které budou komunikovat s workflow modelem pomocí bookmarků.

1.4.1 Návrh

Vzniku každé aplikace by měl předcházet její návrh. Prvním krokem návrhu by mělo
být ujasnění si našich cílů,tedy soupis věcí,které od aplikace požadujeme. Poté se
přesuneme k vlastnímu návrhu průběhu aplikace. V našem případě od aplikace po-
žadujeme aby byla schopna počítat kořeny kvadratických rovnic, otevírat několik
oken a také by bylo vhodné aby aplikace dobře vypadala, o což se postará dříve
zmíněná WPF knihovna. Nic dalšího už od aplikace nepotřebujeme a tak se přesu-
neme k návrhu jejího průběhu. Nejlepším způsobem návrhu stále zůstává metoda,
kdy si vezmeme papír, tužku a nakreslíme jakými stavy bude aplikace procházet.
Tyto stavy by měli být řazeny za sebou v co nejlogičtějším sledu, aby aplikace byla
co nejefektivnější. V našem případě by průběh mohl vypadat zhruba nějak jako na
obrázku ??.

Obr. 1.1: Návrh průběhu

Jak vidíte, schema průběhu naší aplikace není nijak velké, avšak i v takto malých
aplikacích je dobré si jej nakreslit hned z několika důvodů:

• Při vytváření modelu si ujasníme jak bude aplikace fungovat, což je vždy
důležité udělat před začátkem psaní kódu.

• Pokud se při psaní kódu objeví problémy v průběhu, pomocí tohoto schematu
se lépe zorientujeme a snadněji identifikujeme chybu.

Dále je vhodné si do modelu, popřípadě k němu dopsat stručný průběh aplikace
v jednotlivých stavech. V našem modelu to bude vypadat zhruba takto:

1. Ve stavu Start se spustí aplikace a zobrazí první okno ve kterém si uživatel
vybere mezi spuštěním okna pro výpočet, nebo zavřením aplikace(v reálném
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případě by to nebylo nutné, ale pro ukázku předávání informací se to velmi
hodí).

2. Ve stavu druhém, do kterého se aplikace přesune po stisku tlačítka ve stavu
prvním, aplikace otevře okno pro zadání koeficientů a následně bude čekat na
jejich zadání. Po zadání koeficientů uživatel stiskne tlačítko a aplikace postoupí
do dalšího stavu.

3. Ve třetím stavu aplikace pouze vypočítá diskriminant, a dle něj rozhodne zda
bude následovat stav pro výpočet kořenů v případě 𝐷 = 0 a nebo 𝐷 ̸= 0. Po
tomto rozhodnutí se přesune do jednoho z dalších stavů.

4. Ve stavech do kterých se přesune z třetího stavu, se vypočítají kořeny kvadra-
tické rovnice a následně se aplikace přesune do posledního stavu.

5. Ve stavu Konec aplikace otevře okno s výsledky, kam zapíše hodnoty získané
z předchozích stavů. Tím je celý průběh aplikace ukončen a může tedy začít
znovu.

Po dokončení všech těchto kroků máme připraveno vše, co je nutné k vytvoření
aplikace. Můžeme se tedy přesunout k samotné tvorbě.

1.4.2 Vytvoření aplikace

Vytvoření nového Solution a projektu

1. Otevřete Visual Studio 2012.
2. Z horní lišty Visual Studia zvolíme File⇒ New ⇒ Project. . . .
3. V nově otevřeném okně zvolte v jeho levé části položku Other Project Types

a vyberte z ní VisualStudioSolution. Do kolonky Name napište Workflow
a klikněte na OK.

4. V okně Solution Explorer pravým tlačítkem kliněte na položku: Solution
’Workflow’ (0 projects) a z vyskakovacího okna zvolte: Add⇒ New Project. . . .
Otevře se vám znovu okno s výběrem projektů. Teď ovšem rozklikněte po-
ložku Visual C#. Ujistěte se, že v horní části okna máte zvolený .NET Fra-
mework 4 Platform Update 1, vyberte WPF Application, do položky
Name napište Wpf_Ukazka a stiskněte OK. Nakonec stiskněte CTRL+SHIFT+B
k buildnutí a uložení změn.

Tím jsme vytvořili Solution a v něm WPF Aplikaci s kterou budeme dále pracovat.

Vytvoření hlavního okna

Pokud jste udělali správně vše z předchozího kroku, měli by jste v okně Solu-
tion Exploreru vidět soubor MainWindow.xaml a po jeho rozkliknutí i Ma-

13



inWindow.xaml.cs(lze též otevřít pomocí kliknutí pravým tlačítkem na MainWin-
dow.xaml a následně na View Code). Přistoupíme tedy k jejich editaci:

1. Otevřete MainWindow.xaml. V okně Toolbox ze záložky Common WPF
Controls zvolte Label a vložte jej do okna MainWindow. V Properties
okně Labelu mu do okna Content vložte Dobrý den, pokud chcete vypočítat
kořeny kvadratické rovnice, klikněte zde:. Editovat vlastnosti prvků lze i přímo
v XAML kódu, který by jste měli vidět hned pod oknem designeru. Doporu-
čuji však editovat výše uvedeným způsobem, neboť je to rychlejší a pro méně
zkušené uživatele i přehlednější.

2. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna MainWindow. V Properties okně Labelu mu do okna Content
vložte Pokud chcete aplikaci zavřít klikněte zde:.

3. V okně Toolbox ze záložky Common WPF Controls zvolte Button a
vložte jej do okna MainWindow. V Properties okně Buttonu mu do okna
Content vložte Otevřít okno pro zadání koeficientů. V okně Properties klik-
něte na ikonku blesku, čímž se přepnete do events části okna. Dvojklikem
na okénko vedle textu Click vytvoříte on_click_event tlačítka. Pokud vás Vi-
sual Studio přepne do MainWindow.xaml.cs vraťte se zpět do MainWin-
dow.xaml.

4. V okně Toolbox ze záložky Common WPF Controls zvolte Button a
vložte jej do okna MainWindow. V Properties okně Buttonu mu do okna
Content vložte Zavřít. V okně Properties klikněte na ikonku blesku, čímž
se přepnete do events části okna. Dvojklikem na okénko vedle textu Click
vytvoříte on_click_event tlačítka. Pokud jste vše udělali správně, po pře-
pnutí zpět do MainWindow.xaml by vaše okno mělo vypadat podobně jako na
obr.1.2.

5. Nyní se přepneme do okna MainWindow.xaml.cs a kód, který obsahuje
nahradíme následujícím kódem a poté stiskněte CTRL+SHIFT+B k buildnutí
a uložení změn.

using System ;
using System . C o l l e c t i o n s . Generic ;
using System . Linq ;
using System . Text ;
using System . Windows ;
using System . Windows . Contro l s ;
using System . Windows . Data ;
using System . Windows . Documents ;
using System . Windows . Input ;
using System . Windows . Media ;
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using System . Windows . Media . Imaging ;
using System . Windows . Navigat ion ;
using System . Windows . Shapes ;
using System . Threading ;
using System . A c t i v i t i e s ;

namespace Wpf_Ukazka
{

/// <summary>
/// I n t e r a c t i o n l o g i c f o r MainWindow . xaml
/// </summary>
public p a r t i a l class MainWindow : Window
{

//po zapnut í a p l i k a c e se s p u s t í t en to s t a v a o t e v ř e
public MainWindow ( )
{

In i t i a l i z eComponent ( ) ;
}

// p ř i k l i k n u t í na t l a č í t k o 1 s p u s t í WindowState1
public void Button_Click_1 ( ob j e c t sender , RoutedEventArgs e )
{

worker . g e t In s tance ( ) . spust ( ) ;

}
//po k l i k n u t í na t l a č i t k o 2 ukončí a p l i k a c i
private void Button_Click_2 ( ob j e c t sender , RoutedEventArgs e )
{

Appl i ca t ion . Current . Shutdown ( ) ;
}

}

// t ř í d a s t a r a j í c í se o zapnut í a běh workf low
public class worker
{

public s t r i n g Koreny ;
public s t r i n g Numberx1 ;
public s t r i n g Numberx2 ;
public s t r i n g Numberxi1 ;
public s t r i n g Numberxi2 ;

// s i n g l e t o n ins tance
private stat ic worker i n s t ance ;

// s i n g l e t o n Get ter

15



public stat ic worker ge t In s tance ( )
{

i f ( worker . i n s t anc e == n u l l )
{

worker . i n s t ance = new worker ( ) ;
}
return worker . i n s t ance ;

}

// v y t v o ř í novou proměnnou wfApp
WorkflowApplication wfApp ;
// v o t v o ř í novou proměnnou thread
public Thread chi ldThread ;

//po z a v o l á n í metody s p u s t í workf low a p l i k a c i
public void spust ( )
{

// v y t v o ř í novou workf low a p l i k a c i , k t erou namapuje z
ModeluPrubehu

wfApp = new WorkflowApplication (new ModelPrubehu ( ) ) ;

AutoResetEvent syncEvent = new AutoResetEvent ( fa l se ) ;
AutoResetEvent id l eEvent = new AutoResetEvent ( fa l se ) ;

// p r i dokonceni wfApp udě lá n á s l e d u j í c í
wfApp . Completed = de l ega t e (

WorkflowApplicationCompletedEventArgs f )
{

// p ř i ř a d í s t r i n g u Koreny hodnotu , k terou z í s k á z
výs tupu workf low

Koreny = Convert . ToString ( f . Outputs [ " koreny " ] ) ;
Numberx1 = Convert . ToString ( f . Outputs [ " x1 " ] ) ;
Numberx2 = Convert . ToString ( f . Outputs [ " x2 " ] ) ;
Numberxi1 = Convert . ToString ( f . Outputs [ " x i1 " ] ) ;
Numberxi2 = Convert . ToString ( f . Outputs [ " x i2 " ] ) ;

// v o t v o ř í nový ThreadStart pro běh WindowState2
ThreadStart c h i l d r e f = new ThreadStart (OpenWindow2 .

ge t In s tance ( ) . openWindow2) ;
// v y t v o ř í nový thread
chi ldThread = new Thread ( c h i l d r e f ) ;
// nas t a v í thread do STA stavu
chi ldThread . SetApartmentState ( ApartmentState .STA) ;
// s p u s t í thread
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chi ldThread . Sta r t ( ) ;
syncEvent . Set ( ) ;

} ;

// p ř i ukončení workf low v průběhu vyhodí chybu do konzo l e
wfApp . Aborted = de l ega t e (

WorkflowApplicationAbortedEventArgs f )
{

Console . WriteLine ( f . Reason ) ;
syncEvent . Set ( ) ;

} ;

// p ř i neoše t řené podmínce v průběhu a p l i k a c e vyhodí chybu
do konzo l e

wfApp . OnUnhandledException = de l ega t e (
WorkflowApplicationUnhandledExceptionEventArgs f )

{
Console . WriteLine ( f . UnhandledException . ToString ( ) ) ;
return UnhandledExceptionAction . Terminate ;

} ;

// p ř i I d l e s tavu a p l i k a c e zapne i d l eEven t
wfApp . I d l e = de l e ga t e ( Workf lowAppl icat ionIdleEventArgs f )
{

id l eEvent . Set ( ) ;
} ;

// vy t vo ř en í a namapování ex t ens ion
OpenWindow1 okno1 = new OpenWindow1 ( ) ;

OpenWindow2 okno2 = new OpenWindow2 ( ) ;

wfApp . Extens ions . Add( okno1 ) ;
wfApp . Extens ions . Add( okno2 ) ;

wfApp . Run( ) ;
}

//metoda v r a c e j í c í na bookmarky
public void resBook1 ( s t r i n g text0 , s t r i n g text1 , s t r i n g text2 ,

s t r i n g text3 )
{

wfApp . ResumeBookmark ( " Bookmark0 " , t ext0 ) ;
wfApp . ResumeBookmark ( " Bookmark1 " , t ext1 ) ;
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wfApp . ResumeBookmark ( " Bookmark2 " , t ext2 ) ;
wfApp . ResumeBookmark ( " Bookmark3 " , t ext3 ) ;

}

}
}

Obr. 1.2: MainWindow

Díky tomu, že MainWindow je vytvořeno automaticky při vytvoření projektu,
bude po spuštění aplikace hned spuštěna metoda MainWindow() a tedy zobrazeno
první okno. Dále v tomto kódu naleznete metody starající se o on_click_eventy
tlačítek. Třída worker obsahuje dvě metody: první z nich se jmenuje spust a stará
se o vytvoření, spuštění a běh workflow. Můžete si také všimnout, že při dokončení
workflow přiřadí do proměnných výsledky z worfklow a zobrazí okno ve kterých bu-
dou vypsané. Dále třída worker obsahuje ještě singleton instanci, kterou obsahuje z
důvodu potřeby volání jejích metod z jiných tříd. Druhá metoda má jméno resBook1
a stará se o volání bookmarků. Vytvořením tohoto kódu končí úprava hlavního okna.

Vytvoření tříd starajících se o otevírání oken

1. V okně Solution Explorer klikněte pravým tlačítkem na Wpf_Ukázka
a zvolte Add⇒Class. V okně Add New Item zvolíme Class, do Name
napíšeme OpenWindow1 a stiskneme Add.
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2. V nově vytvořené třídě nahradíme aktuální kód tímto:
using System ;
using System . C o l l e c t i o n s . Generic ;
using System . Linq ;
using System . Text ;

namespace Wpf_Ukazka
{

// t ř í d a z a j i š t u j í c í o t e v ř e n í okna
class OpenWindow1
{

public void openWindow1 ( )
{

// v y t v o ř í nové okno a z o b r a z í ho
new WindowState1 ( ) . ShowDialog ( ) ;

}
}

}

Tato třída je velmi jednoduchá a obsahuje jedinou metodu, jejímž úkolem
je vytvořit nové okno a zobrazit jej. Nakonec stiskněte CTRL+SHIFT+B k
buildnutí a uložení změn.

3. V okně Solution Explorer klikněte pravým tlačítkem na Wpf_Ukázka
a zvolte Add⇒Class. V okně Add New Item zvolíme Class, do Name
napíšeme OpenWindow2 a stiskneme Add. V této třídě kód nahradíme násle-
dujícím:
using System ;
using System . C o l l e c t i o n s . Generic ;
using System . Linq ;
using System . Text ;

namespace Wpf_Ukazka
{

class OpenWindow2
{

public void openWindow2 ( )
{

new WindowState2 ( ) . ShowDialog ( ) ;
}

// dek l a rován í s i n g l e t o n ins tance
private stat ic OpenWindow2 in s t ance ;
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//pokud j e in s tance nulová , v y t v o ř í novou . pokud ne , v r á t í
a k t u á l n í

public stat ic OpenWindow2 ge t In s tance ( )
{

i f (OpenWindow2 . i n s t ance == n u l l )
{

OpenWindow2 . i n s t ance = new OpenWindow2 ( ) ;
}
return OpenWindow2 . i n s t ance ;

}
}

}

Tato třída obsahuje též metodu na vytvoření a zobrazení okna. Navíc je
zde použita instance, aby bylo možné na třídu odkazovat. Nakonec stiskněte
CTRL+SHIFT+B k buildnutí a uložení změn. Tím jsme vytvořili všechny
třídy, které budeme potřebovat k ovládání aplikace.

Vytvoření vlastních CodeActivit

1. V okně Solution Explorer klikneme pravým tlačítkem na Wpf_Ukázka a
zvolíme Add⇒New Item. . . . V okně Add New Item klikneme na Visual
C#,z nabídky zvolíme Workflow a vybereme CodeActivity. Do Name
napíšeme OpenWindowActivity a stiskneme Add.

2. Kód uvnitř aktivity nahradíme :
using System ;

using System . C o l l e c t i o n s . Generic ;
using System . Linq ;
using System . Text ;
using System . A c t i v i t i e s ;
using System . Threading ;

namespace Wpf_Ukazka
{

public s e a l ed class OpenWindowActivity : Nat iveAct iv i ty <s t r i ng
>

{
// Def inu je v s tupn í argument a k t i v i t y tupu s t r i n g
[ RequiredArgument ]
public InArgument<s t r i ng > BookmarkName { get ; s e t ; }

public stat ic Thread chi ldThread ;
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//po z a v o l á n í CodeAct iv i ty udě lá n á s l e d u j í c í
protected o ve r r i d e void Execute ( Nat iveAct iv i tyContext

context )
{

// načte ex t ens ion
OpenWindow1 ext = context . GetExtension<OpenWindow1>() ;
// v y t v o ř í nový thread
chi ldThread = new Thread ( ext . openWindow1) ;
// nas t a v í thread do STA stavu
chi ldThread . SetApartmentState ( ApartmentState .STA) ;
// s p u s t í thread
chi ldThread . Sta r t ( ) ;
// v y t v o ř í Bookrmark na k t e r ý čeká dokud není zavo lán
context . CreateBookmark (BookmarkName . Get ( context ) ,
new BookmarkCallback (OnResumeBookmark) ) ;

}

protected o ve r r i d e bool CanInduceIdle
{

get { return true ; }
}

//po z a v o l á n í bookmarku s p u s t í t u t o metodu
public void OnResumeBookmark( Nat iveAct iv i tyContext context

, Bookmark bookmark , ob j e c t obj )
{

// p ř i ř a d í do Resu l t hodnotu př inesenou bookmarkem
this . Result . Set ( context , ( obj ) ) ;

}
}

}

Díky zvolení dědění vlastností z NativeActivity jsme získali možnost použí-
vat Bookmarky a díky agrumentu string možnost předat jí string hodnotu
do Result proměnné. Tato CodeActivita při spuštění získá extension Ope-
nWindow1 a přidělí jí nový thread, který nastaví do STA stavu a na kterém
následně spustí metodu OpenWindow1. Poté začne čekat na zavolání je-
jího Bookmarku. Po vyvolání Bookmarku přířadí do její proměnné Result
hodnotu, kterou Bookmark dostane při jeho volání.

3. V okně Solution Explorer klikneme pravým tlačítkem na Wpf_Ukázka a
zvolíme Add⇒New Item. . . . V okně Add New Item klikneme na Visual
C#,z nabídky zvolíme Workflow a vybereme CodeActivity. Do Name
napíšeme ReadLine a stiskneme Add.
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4. Kód uvnitř aktivity nahraďte následujícím a poté stiskněte CTRL+SHIFT+B
k buildnutí a uložení změn.
using System ;
using System . C o l l e c t i o n s . Generic ;
using System . Linq ;
using System . Text ;
using System . A c t i v i t i e s ;

namespace Wpf_Ukazka
{

public s e a l ed class ReadLine : Nat iveAct iv i ty <int>
{

[ RequiredArgument ]
public InArgument<s t r i ng > BookmarkName { get ; s e t ; }

protected o ve r r i d e void Execute ( Nat iveAct iv i tyContext
context )

{
// Vytvoř í Bookmark a čeká dokud nebude zavo lán
context . CreateBookmark (BookmarkName . Get ( context ) ,

new BookmarkCallback (OnResumeBookmark) ) ;
}

// N a t i v e A c t i v i t y obsahuje a c t i v i t i y , k t e r é mohou d ě l a t
asynchronní operace voláním jednoho

// z CreateBookmark over loadů de f inovaných v System .
A c t i v i t i e s . Na t i v eAc t i v i t yCon tex t

// musí p ř e p i s o v a t CanInduceIdle v l a s t n o s t i a v race t t rue .

protected o ve r r i d e bool CanInduceIdle
{

get { return true ; }
}

public void OnResumeBookmark( Nat iveAct iv i tyContext context
, Bookmark bookmark , ob j e c t obj )

{
// Po z a v o l á n í Bookmarku nas t a v í do Resu l t hodnotu z

ob j
this . Result . Set ( context , Convert . ToInt32 ( obj ) ) ;

}
}

}
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Tato aktivita po spuštění začne čekat na zavolání Bookmarku. Po jeho vyvolání
zapíše do své proměnné Result hodnotu, kterou Bookmark obdržel při jeho
volání.

Další CodeActivity nebudeme v našem případě potřebovat a tak se přesuneme
k dalšímu kroku.

Vytvoření oken pro zadání koeficientů a zobrazení výsledků

1. V okně Solution Explorer klikněte pravým tlačítkem na Wpf_Ukázka a
zvolte Add⇒New Item. . . . V okně Add New Item klikněte na Visual
C#,z nabídky zvolte WPF a vyberte Window(WPF). Do Name napíšeme
WindowState1 a stiskněte Add.

2. V okně Toolbox ze záložky Common WPF Controls zvolte Button a
vložte jej do okna WindowState1. V Properties okně Buttonu mu do okna
Content vložte Vypočítat. V okně Properties klikněte na ikonku blesku,
čímž se přepnete do events části okna. Dvojklikem na okénko vedle textu
Click vytvoříte on_click_event tlačítka. Pokud vás Visual Studio přepne do
WindowState1.xaml.cs vraťte se zpět doWindowState1.xaml.

3. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState1. V Properties okně Labelu mu do okna Con-
tent vložte a:.

4. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState1. V Properties okně Labelu mu do okna Con-
tent vložte b:.

5. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState1. V Properties okně Labelu mu do okna Con-
tent vložte c:.

6. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState1. V Properties okně Labelu mu do okna Con-
tent vložte Zadejte prosím koeficienty kvadratické rovnice:.

7. V okně Toolbox ze záložky Common WPF Controls zvolte TextBox
a vložte jej do okna WindowState1. V Properties okně TextBoxu mu
smažte obsah Text okna. Tím zajístíte, že v TextBoxu nic nebude. Dále mu
v okně Properties nastavte do Name okna jméno TextBox1.

8. V okně Toolbox ze záložky Common WPF Controls zvolte TextBox
a vložte jej do okna WindowState1. V Properties okně TextBoxu mu
smažte obsah Text okna. Tím zajístíte, že v TextBoxu nic nebude. Dále mu
v okně Properties nastavte do Name okna jméno TextBox2.

9. V okně Toolbox ze záložky Common WPF Controls zvolte TextBox
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a vložte jej do okna WindowState1. V Properties okně TextBoxu mu
smažte obsah Text okna. Tím zajístíte, že v TextBoxu nic nebude. Dále mu
v okně Properties nastavte do Name okna jméno TextBox3.

10. Klikněte na WindowState1. V Properties okně WindowState1 mu do Name
okna nastavte jméno Okno pro zadání koeficientů. Výsledné okno by mělo
vypadat jako na obr.1.3

Obr. 1.3: Okno pro zadání koeficientů

11. Ve WindowState1.xaml.cs nahradíme vygenerovaný kód následujícím:
using System ;
using System . C o l l e c t i o n s . Generic ;
using System . Linq ;
using System . Text ;
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using System . Windows ;
using System . Windows . Contro l s ;
using System . Windows . Data ;
using System . Windows . Documents ;
using System . Windows . Input ;
using System . Windows . Media ;
using System . Windows . Media . Imaging ;
using System . Windows . Shapes ;

namespace Wpf_Ukazka
{

/// <summary>
/// I n t e r a c t i o n l o g i c f o r Window1 . xaml
/// </summary>
public p a r t i a l class WindowState1 : Window
{

public WindowState1 ( )
{

In i t i a l i z eComponent ( ) ;
}

//po k l i k n u t i na t l a c i t k o s p u s t i
private void Button_Click_1 ( ob j e c t sender , RoutedEventArgs

e )
{

// v y t o r i s t r i n g
s t r i n g a ; s t r i n g b ; s t r i n g c ;
s t r i n g fn = " ahoj " ;

// pokud v t e x t boxu po s t i s k u t l a č i t k a nebude nic ,
vyhodí messagebox

i f ( s t r i n g . IsNullOrEmpty ( TextBox1 . Text . ToString ( ) ) )
{

MessageBox . Show( " Zadej te prosím č í s l o a " ) ;
return ;

}
i f ( s t r i n g . IsNullOrEmpty ( TextBox2 . Text . ToString ( ) ) )
{

MessageBox . Show( " Zadej te prosím č í s l o b " ) ;
return ;

}
i f ( s t r i n g . IsNullOrEmpty ( TextBox3 . Text . ToString ( ) ) )
{

MessageBox . Show( " Zadej te prosím č í s l o c " ) ;
return ;

}
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// p ř i ř a d í do s t r i n g u obsah TextBoxu
a = TextBox1 . Text . ToString ( ) ;
b = TextBox2 . Text . ToString ( ) ;
c = TextBox3 . Text . ToString ( ) ;
// v r á t í se na bookmark s obsahem tex t boxu (a )
worker . g e t In s tance ( ) . resBook1 ( fn , a , b , c ) ;
// zavře okono
this . Close ( ) ;

}

private void TextBox1_TextChanged ( ob j e c t sender ,
TextChangedEventArgs e )

{
double a ;
i f ( ! double . TryParse ( TextBox1 . Text , out a ) )
{

//Pokud do t e x t boxu nenap í še t e Int , v y č i s t í ho
TextBox1 . Clear ( ) ;

}
}
private void TextBox2_TextChanged ( ob j e c t sender ,

TextChangedEventArgs e )
{

double a ;
i f ( ! double . TryParse ( TextBox2 . Text , out a ) )
{

TextBox2 . Clear ( ) ;
}

}
private void TextBox3_TextChanged ( ob j e c t sender ,

TextChangedEventArgs e )
{

double a ;
i f ( ! double . TryParse ( TextBox3 . Text , out a ) )
{

TextBox3 . Clear ( ) ;
}

}
}

}

Tento kód hned po spuštění otevře okno a po kliku na tlačítko zkontroluje,
zda nejsou TextBoxy prázdné(pokud ano tak vyhodí MessageBox s žádostí o
zadání daného čísla), pokud nejsou přiřadí do stringů hodnoty z TextBoxů,
které následně předá pomocí bookmarku do workflow. Metody TextChanged
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zajišťují, že uživatel bude moci zadávat do TextBoxů pouze čísla. Zajišťují
to pomocí jednoduchého TextChanged eventu, při kterém zjistí typ znaku
zadaného do TextBoxu a pokud to není integer, vymaže ho.

12. V okně Solution Explorer klikněte pravým tlačítkem na Wpf_Ukázka a
zvolte Add⇒New Item. . . . V okně Add New Item klikněte na Visual
C#,z nabídky zvolte WPF a vyberte Window(WPF). Do Name napíšeme
WindowState2 a stiskněte Add.

13. V okně Toolbox ze záložky Common WPF Controls zvolte Button a
vložte jej do okna WindowState2. V Properties okně Buttonu mu do
okna Content vložte Zavřít. V okně Properties klikněte na ikonku blesku,
čímž se přepnete do events části okna. Dvojklikem na okénko vedle textu
Click vytvoříte on_click_event tlačítka. Pokud vás Visual Studio přepne do
WindowState2.xaml.cs vraťte se zpět doWindowState2.xaml.

14. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState2. V Properties okně Labelu mu do okna Con-
tent vložte Vypočítané kořeny jsou:.

15. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState2. V Properties okně Labelu mu do okna Con-
tent vložte x1:.

16. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState2. V Properties okně Labelu mu do okna Con-
tent vložte x2:.

17. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState2. V Properties okně Labelu mu do okna Con-
tent vložte +.

18. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState2. V Properties okně Labelu mu do okna Con-
tent vložte *j.

19. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState2. V Properties okně Labelu mu do okna Con-
tent vložte *j.

20. V okně Toolbox ze záložky Common WPF Controls zvolte Label a vložte
jej do okna WindowState2. V Properties okně Labelu mu okno Content
nechte prázdné(smažte jeho obsah).

21. V okně Toolbox ze záložky Common WPF Controls zvolte TextBox
a vložte jej do okna WindowState2. V Properties okně TextBoxu mu
smažte obsah Text okna. Tím zajístíte, že v TextBoxu nic nebude. Dále mu
v okně Properties nastavte do Name okna jméno TextBoxX1.
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22. V okně Toolbox ze záložky Common WPF Controls zvolte TextBox
a vložte jej do okna WindowState2. V Properties okně TextBoxu mu
smažte obsah Text okna. Tím zajístíte, že v TextBoxu nic nebude. Dále mu
v okně Properties nastavte do Name okna jméno TextBoxX2.

23. V okně Toolbox ze záložky Common WPF Controls zvolte TextBox
a vložte jej do okna WindowState2. V Properties okně TextBoxu mu
smažte obsah Text okna. Tím zajístíte, že v TextBoxu nic nebude. Dále mu
v okně Properties nastavte do Name okna jméno TextBoxXi1.

24. V okně Toolbox ze záložky Common WPF Controls zvolte TextBox
a vložte jej do okna WindowState2. V Properties okně TextBoxu mu
smažte obsah Text okna. Tím zajístíte, že v TextBoxu nic nebude. Dále mu
v okně Properties nastavte do Name okna jméno TextBoxXi2.

25. Klikněte na WindowState2. V Properties okně WindowState2 mu do Name
okna nastavte jméno Okno s výsledky. Výsledné okno by mělo vypadat jako na
obr.1.4 (label bez obsahu je vpravo od labelu s obsahem Vypočítané kořeny)

Obr. 1.4: Okno s výsledky

28



26. Nyní nahradíme kód WindowState2.xaml.cs následujícím:
using System ;
using System . C o l l e c t i o n s . Generic ;
using System . Linq ;
using System . Text ;
using System . Windows ;
using System . Windows . Contro l s ;
using System . Windows . Data ;
using System . Windows . Documents ;
using System . Windows . Input ;
using System . Windows . Media ;
using System . Windows . Media . Imaging ;
using System . Windows . Shapes ;

namespace Wpf_Ukazka
{

/// <summary>
/// I n t e r a c t i o n l o g i c f o r Window2 . xaml
/// </summary>
public p a r t i a l class WindowState2 : Window
{

public WindowState2 ( )
{

// zapni okno
In i t i a l i z eComponent ( ) ;
TextBoxX1 . Text = worker . g e t In s tance ( ) . Numberx1 ;

//do t e x t boxu p ř i ř a d í hodnotu z Numberx1
TextBoxXi1 . Text = worker . g e t In s tance ( ) . Numberxi1 ;
TextBoxX2 . Text = worker . g e t In s tance ( ) . Numberx2 ;
TextBoxXi2 . Text = worker . g e t In s tance ( ) . Numberxi2 ;
Koreny . Content = worker . g e t In s tance ( ) . Koreny ;

}

private void Button_Click_1 ( ob j e c t sender , RoutedEventArgs
e )

{
// ukončí thread a zavře okno . ukončení threadu j e zde

jen pro j i s t o t u
worker . g e t In s tance ( ) . chi ldThread . Abort ( ) ;
this . Close ( ) ;

}
}

}

Tento kód hned po spuštění otevře okno a přiřadí TextBoxům hodnoty uložené
v proměnných Numberx1,Numberxi1,Numberx2,Numberxi2 a Labelu přiřadí
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hodnotu uloženou v proměnné Koreny. Při stisku tlačítka ukončí Thread na
kterém běží a zavře se.

Vytvoření modelu průběhu

1. V okně Solution Explorer klikneme pravým tlačítkem na Wpf_Ukázka a
zvolíme Add⇒New Item. . . . V okně Add New Item klikneme na Visual
C#,z nabídky zvolíme Workflow a vybereme Activity. Do Name napíšeme
ModelPrubehu a stiskneme Add.

2. V Toolboxu vybereme záložku State Machine a z ní StateMachine, které
vložíme do v předchozím bodě vytvořené Activity.

3. Ze stejného místa v Toolboxu do Activity vložíme ještě dvakrát State a jed-
nou FinalState. První State při vkládaní přibližte k automaticky vygenero-
vanému stavu(State1). Objeví se malý trojúhelník, na který když jej přiložíte,
automaticky se mezi stavy vytvoří transition.

4. U druhého Statu to již nebude možné, protože chceme aby sdíleli trigger.
Takže jej vložte pouze do StateMachine Activity. Následně najeďte myší na
kolečko, odkud vychází transition z prvního Statu a kliknutím a tažením jej
napojte na State3.

5. Nakonec z Toolboxu vyberte FinalState a vložte jej do StateMachine Acti-
vity. Z obou Statů vytvořených v předchozích bodech(stavy State2 a State3)
vytvořte transition do FinalState. Celé workflow by mělo vypadat jako na
obr. 1.5

Obr. 1.5: Model průběhu
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6. Dole na liště WorkflowDesigneru klikněte na Variables. V zobrazeném
okně klikněte na Create Variable. Do name napište D, Variable type zvolte
Double(poprvé se nezobrazí a tak musíte z nabídky zvolit Browse For Types,
v nově otevřeném okně napsat nahoře do Type Name: Double a vybrat
System→Double.).

7. Dole na liště WorkflowDesigneru klikněte na Arguments. V zobrazeném
okně klikněte na Create Argument. Do name napište x1, Direction zvolte
Out, Argument type zvolte Double(poprvé se nezobrazí a tak musíte z na-
bídky zvolit Browse For Types, v nově otevřeném okně napsat nahoře do Type
Name: Double a vybrat System→Double.).

8. Klikněte na Create Argument. Do name napište x2, Direction zvolte Out,
Argument type zvolte Double.

9. Klikněte na Create Argument. Do name napište xi1, Direction zvolte Out,
Argument type zvolte Double.

10. Klikněte na Create Argument. Do name napište xi2, Direction zvolte Out,
Argument type zvolte Double.

11. Klikněte na Create Argument. Do name napište koreny, Direction zvolte
Out, Argument type zvolte String.

12. Klikněte na Create Argument. Do name napište a, Direction zvolte In,
Argument type zvolte Int32.

13. Klikněte na Create Argument. Do name napište b, Direction zvolte In,
Argument type zvolte Int32.

14. Klikněte na Create Argument. Do name napište c, Direction zvolte In,
Argument type zvolte Int32.

15. Dvakrát klikněte na State1, čímž se přesunete dovnitř stavu. Klikněte na
State1 v titulku stavu, a přejmenujte jej na OpenAndReadState.

16. V Toolboxu ze záložky Control Flow vyberte Sequence a vložte ji do okna
Entry.

17. V Toolboxu ze záložky Wpf_Ukazka vyberte OpenWindowActivity a vložte
ji do Sequence. Označte OpenWindowActivity a v okně Properties do Bookmark-
Name zadejte ”𝐵𝑜𝑜𝑘𝑚𝑎𝑟𝑘0”.

18. V Toolboxuze záložky Wpf_Ukazka vyberte ReadLine a vložte ji do Sequence
pod OpenWindowActivity. Vytvořenou ReadLine označte a v okně Pro-
perties do BookmarkName zadejte ”𝐵𝑜𝑜𝑘𝑚𝑎𝑟𝑘1” a do Result a.

19. V Toolboxu ze záložky Wpf_Ukazka vyberte ReadLine a vložte ji do Sequence
pod přechozí ReadLine. Vytvořenou ReadLine označte a v okně Properties
do BookmarkName zadejte ”𝐵𝑜𝑜𝑘𝑚𝑎𝑟𝑘2” a do Result b.

20. V Toolboxu ze záložky Wpf_Ukazka vyberte ReadLine a vložte ji do Sequence
pod přechozí ReadLine. Vytvořenou ReadLine označte a v okně Proper-
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ties do BookmarkName zadejte ”𝐵𝑜𝑜𝑘𝑚𝑎𝑟𝑘3” a do Result c.Výsledný stav
by měl vypadat jako na obr.1.6. Klikněte na ModelPrubehu pro návrat zpět
k zobrazení celého workflow.

Obr. 1.6: OpenAndReadState

21. Dvojklikem na Transition vedoucí z OpenAndReadState do něj přejděte.
Následně jej přejmenujte na D<>0. Do okna Trigger vložte z Toolboxu ze
sekce Primitives aktivitu Assign. V Properties okně do jejího okna To
vložte D a do Value (𝑏 * 𝑏) − 4 * 𝑎 * 𝑐. Do Condition vložte D<>0.
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22. Kliknutím na State2 v dolní části Transition okna do něj přejděte. Po ote-
vření jej přejmenujte na CalculatingState1.

23. V Toolboxu ze záložky Control Flow vyberte If aktivitu a vložte ji do
Entry okna CalculatinState1. Do Condition If aktivity vložte 𝐷 > 0.

24. V Toolboxu ze záložky Control Flow vyberte Sequence a vložte ji do
Then okna If aktivity. Do ní vložte z Toolboxu ze sekce Primitives aktivitu
Assign. V Properties okně Assing aktivity do jejího okna To vložte koreny
a do Value ”𝑟𝑒á𝑙𝑛é”.

25. V Toolboxu ze sekce Primitives vyberte aktivitu Assign a vložte ji za
Assign aktivitu z předchozího bodu. V Properties okně nové Assign aktivity
do jejího okna To vložte x1 a do Value (−𝑏 + (𝐷(1/2))/2 * 𝑎).

26. V Toolboxu ze sekce Primitives vyberte aktivitu Assign a vložte ji za
Assign aktivitu z předchozího bodu. V Properties okně nové Assign aktivity
do jejího okna To vložte x2 a do Value (−𝑏 − (𝐷(1/2))/2 * 𝑎).

27. V Toolboxu ze záložky Control Flow vyberte Sequence a vložte ji do
Else okna If aktivity. Do ní vložte z Toolboxu ze sekce Primitives aktivitu
Assign. V Properties okně Assing aktivity do jejího okna To vložte koreny
a do Value ”𝑘𝑜𝑚𝑝𝑙𝑒𝑥𝑛í”.

28. V Toolboxu ze sekce Primitives vyberte aktivitu Assign a vložte ji za
Assign aktivitu z předchozího bodu. V Properties okně nové Assign aktivity
do jejího okna To vložte x1 a do Value −𝑏/(2 * 𝑎).

29. V Toolboxu ze sekce Primitives vyberte aktivitu Assign a vložte ji za
Assign aktivitu z předchozího bodu. V Properties okně nové Assign aktivity
do jejího okna To vložte xi1 a do Value ((−𝐷)̂(1/2))/(2 * 𝑎).

30. V Toolboxu ze sekce Primitives vyberte aktivitu Assign a vložte ji za
Assign aktivitu z předchozího bodu. V Properties okně nové Assign aktivity
do jejího okna To vložte x2 a do Value −𝑏/(2 * 𝑎).

31. V Toolboxu ze sekce Primitives vyberte aktivitu Assign a vložte ji za As-
sign aktivitu z předchozího bodu. V Properties okně nové Assign aktivity
do jejího okna To vložte xi2 a do Value −((−𝐷)̂(1/2))/(2 * 𝑎). Celý Calcula-
tingState1 by měl vypadat jako na obr.1.7.

32. Klikněte na ModelPrubehu pro návrat a následně se dvojklikem na druhou
transition přesuňte do jejího designu. Uvnitř by měl již být Trigger(sdílený
s první transition), takže pouze do pole Condition vložte 𝐷 = 0.

33. Kliknutím na State3 vedle Destination: se přesuntě do stavu 3. Přejmenujte
jej na CalculatingState2.

34. V Toolboxu ze záložky Control Flow vyberte Sequence a vložte ji do En-
try okna CalculatingState2. Do ní vložte z Toolboxu ze sekce Primitives
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Obr. 1.7: CalculatingState1

34



aktivitu Assign. V Properties okně Assing aktivity do jejího okna To vložte
koreny a do Value ”𝑟𝑒á𝑙𝑛é”.

35. V Toolboxu ze sekce Primitives vyberte aktivitu Assign a vložte ji za
Assign aktivitu z předchozího bodu. V Properties okně nové Assign aktivity
do jejího okna To vložte x1 a do Value −𝑏/(2 * 𝑎).

36. V Toolboxu ze sekce Primitives vyberte aktivitu Assign a vložte ji za
Assign aktivitu z předchozího bodu. V Properties okně nové Assign aktivity
do jejího okna To vložte x2 a do Value −𝑏/(2 * 𝑎). CalculatingState2 by měl
vypadat jako na obr. 1.8

Obr. 1.8: CalculatingState2

Tímto jsme vytvořili model průběhu naší aplikace, což bylo posledním krokem
naší tvorby. Stiskem CTRL + SHIFT + B buildněte solution a následně spusťte
aplikaci.
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2 VÝSLEDKY STUDENTSKÉ PRÁCE

2.1 Workflow peer-to-peer piškvorky
Úkolem mé práce bylo navrhnout peer-to-peer piškvorky pro dva hráče pomocí WPF
a workflow. Bohužel při vytváření této aplikace nastaly problémy, které mi nakonec
znemožnili v aplikaci plně zprovoznit workflow model. Aplikace peer-to-peer piškvo-
rek je přiložena v přílohách ve stavu, do jakého jsem ji byl schopen zprovoznit. Nyní
bych se tedy rád pokusil nejzásadnější a nejčastější problémy v následujícím textu
popsat.

• Prvním a dosud nevyřešeným problémem je eror, zobrazený na obr.2.1

Obr. 2.1: Error při použití InvokeMethod Aktivity

Tento error se objeví kdykoliv ve workflow modelu použiji InvokeMethod ak-
tivitu. Problém se objevuje i v případě, že aktivitu používám přesně podle ná-
vodu vývojářů. Podle mnou získaných informací by měl jít odstranit správným
nastavením namespaců XAML souboru. Bohužel nemohu tuto teorii potvrdit,
jelikož se mi to nepovedlo. Díky tomuto eroru jsem tedy přišel o možnost volat
jednotlivé metody z přímo z workflow. Zůstala tedy možnost sestavit workflow
celé z custom CodeActivit.

• Druhým problémem který mě velice dlouho trápil bylo, že jsem nemohl najít v
žádných zdrojích jak zkombinovat WPF a workflow v jedné aplikaci. (Všechny
zdroje předpokládají že workflow bude konzolová či webová aplikace a WPF
neřeší, stejně tak ve WPF aplikacích a jejich dokumentacích nikdo nepočítá
s workflow.) Nemohl jsem zjistit, jak předávat informace z workflow do oken
WPF, ani jak z workflow spustit WPF okna a naopak. Tento problém jsem
nakonec vyřešil, jak je vidět z vzorové aplikace popsané výše. Workflow se
totiž dá spustit z jakéhokoliv eventu (například ze stisku tlačítka), avšak díky
poněkud nešťastnému řešení WPF oken bylo nutné pro spouštění workflow
vytvořit speciální třídu obsahující metodu na spouštění a spravování průběhu
workflow. V této třídě bylo nutné vytvořit ješte singleton instanci, pro možnost
na třídu odkazovat. Naopak pro spouštění WPF oken z workflow, bylo nutné
použít extensions. Jako extension se do workflow aplikace přidá třída obsa-
hující metodu spouštějící okno. Ta se následně například pomocí bookmarku
vyvolá a nové okno se zobrazí. Tato cesta je sice zdlouhavá a nejspíše jsou i
jiná řešení, avšak důležité je, že funguje.
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• Třetím problémem bylo, že po vytvoření workflow aplikace a jejím spuštění
worfklow proběhlo, avšak visuálně se nic nezměnilo a Visual Studio 2010 ne-
našlo žádné errory. Tato chyba byla nejspíše způsobena absencí všech stavů
workflow aplikace. Při jejím vytvoření tedy bylo nutné vždy definovat stavy
completed,idle atd. . . .

• Čtvrtým problémem, který bylo nutné odstranit pro správný běh aplikace, byla
skutečnost, že při pokusu otevřít jakékoliv WPF okno z workflow aplikace
vyhodila error. Tento error vypadal následovně: The calling thread must be
STA, because many UI components require this. V praxi šlo o problém který
se běžně řeší Background workerem. V mnou prezentovaném kódu(je součásti
Vzorového příkladu) je tento problém vyřešen pomocí extensions a následným
vytvořením nového Threadu, který se po vytvoření nastaví do STA stavu.

• Posledním významným problémem byla samotná peer-to-peer komunikace.
Workflow by k podobným případům mělo používat SendActivity. Tyto aktivity
jsou součástí workflow a vypadají jako velmi vhodný a rozumně definovaný pr-
vek. Jsou zde i RecieveAndSendReply a SendAndRecieveReply aktivity, které
jsou jako stvořené pro komunikaci mezi aplikacemi. Bohužel však nikde není k
sehnání dokumentace jak komunikaci pomocí těchto aktivit zprovoznit. Vzhle-
dem k tomuto faktu jsem se nakonec rozhodl k této komunikaci použít klasické
funkce knihovny WCF. K přijímání a odesílání dat jsem vytvořil třídy, které
jsou součástí přiložené aplikace s názvem piškvorky. Fungují za pomocí definice
EndPointu a následného sestavení spojení mezi dvěmi aplikacemi. Samotná
komunikace pak probíhá asynchronně pomocí asynchronních callbacku.

• Dále se vyskytlo několik menších problémů týkajících se workflow, avšak tyto
problémy byly způsobeny pouze mou neznalostí a špatnou dostupností materi-
álů, které by daný problém objasňovali. Všechny tyto problémy jsem nakonec
tedy dokázal nějakým způsobem buď obejít, nebo vyřešit. Bohužel zkoušení
různých řešení a hledání podkladů mi zabralo tolik času, že jsem již nestihl
aplikaci piškvorek přepsat a tak jsem funkce a možnosti aplikací vytvořených
pomocí workflow a WPF demonstroval na jednoduchém příkladu výpočtu Kva-
dratických rovnic.
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2.2 Aplikace pro výpočet kořenů kvadratických
rovnic

V první části této práce jsem popsal návrh a následně i postup vytvoření aplikace
pro výpočet kořenů kvadratických rovnic. Účelem této aplikace je hlavně uživatele
seznámit s možnostmi kombinace WPF a workflow. Součástí kódu je několik tříd,
ve kterých je za pomocí Bookmarků, Instancí a eventů zajištěna komunikace mezi
uživatelem, WPF okny a samotným workflow. Je zde také krásně vidět řešení pro-
blému, popsaných v předchozí kapitole. Celý kód je přehledně komentován pro snašší
orientaci a lepší přehlednost.
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3 ZÁVĚR
Účelem celé mé práce bylo seznámit čtenáře s možnostmi aplikací tvořených za po-
moci Windows Workflow Foundation a Windows Presentation Foundation knihoven
z .NET Frameworku 4.0. Ve vzorovém příkladu se snažím co nejpřehledněji a nej-
názorněji předvést postup návrhu a tvorby aplikace. Při samotné tvorbě se snažím
popsat jednotlivé funce a metody, aby měl čtenář stále přehled o právě používaných
metodách a funkcích kódu. Nejdůležitějšími poznatky, které tato práce ukazuje jsou
spolupráce workflow a WPF a práce s metodami podporujícími tuto spolupráci.

Na závěr bych se ještě rád zmínil o workflow technologii a přístupu jejích au-
torů k ní. Nápad a směr, jakým se snaží WF jít jsou dle mého názoru správné a
velice ambiciózní. Pokud by se WF rozšířilo a začalo užívat například ve velkých
vývojových týmech, mohlo by ušetřit práci a hlavně dovolit například manažerům
pouze tvořit WF modely z aktivit, které by jim programátoři předepsali. Tím by
se docílilo toho, že by se manažeři mohli plně soustředit na vývoj workflow, a ne-
museli se rozptylovat kódem, který pracuje na pozadí. Na druhou stranu já osobně
bych dal přednost „klasickému“ programování, protože celá workflow nadstavba mi
přijde zbytečně náročná a zpomalující běh celého programu. Navíc když se podí-
váme na dostupnost materiálů k workflow, zjistíme, že sehnat kvalitní materiály je
velmi náročné. Microsoft na svých stránkách(MSDN Library) sice nějaké materiály
k workflow má, ale většinou jsou hodně stručné a občas by mnohem více pomohli
názorné příklady. Microsoft navíc vydává nové verze WF tak rychle, že často nestačí
aktualizovat dokumenty a pak méně zkušeným uživatelům nezbývá nic jiného než
používat starší verzi, neboť v nové jsou například změněny syntaxe příkazů. Nejvíce
mě ale překvapil fakt, že jediným člověkem snažícím se uživatelům představit mož-
nosti workflow je Ron Jacobs, který na praktických příkladech vysvětluje jednotlivé
funkce. Do budoucna doufám že materiálů k worfklow přibude, a bude tak mnohem
snaží se s touto technologií naučit pracovat a plně ji využívat.
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A PŘÍLOHY

A.1 Obsah Přiloženého CD
Přiložené DvD obsahuje dva adresáře:

/UkazkovePriklady obsahuje jeden podadresář a tři soubory:

Podadresář: /Piskvorky
Tento podadresář obsahuje zdrojové kódy a soubory potřebné pro aplikaci piškvo-

rek

1.soubor: /packages
Tento soubor obsahuje zdrojové kódy a soubory potřebné pro správný debug

aplikace piškvorek

2.soubor: /ReadMe
Tento soubor obsahuje informace k aplikaci uložené v adresáři /UkazkovePriklady

3.soubor: /UkazkovePriklady Solution soubor Visual Studia

Workflow obsahuje jeden adresář a jeden soubor:

Podadresář: /Piskvorky
Tento podadresář obsahuje zdrojové kódy a soubory potřebné pro ukázkovou

aplikaci

Soubor: /packages
Tento soubor obsahuje zdrojové kódy a soubory potřebné pro správný debug

ukázkové aplikace
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